
Startup Guide

SD1 3.x Software

for M31xxA Digitizers, M32xxA AWGs & M33xxA Combos



Notices
© Keysight Technologies 2020-2021

No part of this manual may be reproduced 
in any form or by any means (including 
electronic storage and retrieval or transla-
tion into a foreign language) without prior 
agreement and written consent from 
Keysight Technologies as governed by 
United States and international copyright 
laws.

Manual Part Number
M3xxx-90002

Edition

Edition 1.3, May 2021

Available in electronic format only

Published by
Keysight Technologies, Inc.
1900 Garden of the Gods Road
Colorado Springs, CO 80907 USA

Technology Licenses
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer 
software,” as defined by Federal Acquisition 
Regulation (“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement 

(“DFARS”) 227.7202, the U.S. government 
acquires commercial computer software 
under the same terms by which the 
software is customarily provided to the 
public. Accordingly, Keysight provides the 
Software to U.S. government customers 
under its standard commercial license, 
which is embodied in its End User License 
Agreement (EULA), a copy of which can 

be found at: 
http://www.keysight.com/find/sweula. 
The license set forth in the EULA represents 
the exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require 
or permit, among other things, that 
Keysight: (1) Furnish technical information 
related to commercial computer software 
or commercial computer software 
documentation that is not customarily 
provided to the public; or (2) Relinquish to, 
or otherwise provide, the government 
rights in excess of these rights customarily 
provided to the public to use, modify, 
reproduce, release, perform, display, or 
disclose commercial computer software or 
commercial computer software documen-
tation. No additional government require-
ments beyond those set forth in the EULA 
shall apply, except to the extent that those 
terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as 
applicable in any technical data. 

Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED "AS IS," AND IS 
SUBJECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED WITH REGARD TO THIS MANUAL 
AND ANY INFORMATION CONTAINED 

HEREIN, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. KEYSIGHT SHALL 
NOT BE LIABLE FOR ERRORS OR FOR 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES IN CONNECTION WITH THE 
FURNISHING, USE, OR PERFORMANCE OF 
THIS DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD KEYSIGHT 
AND THE USER HAVE A SEPARATE 
WRITTEN AGREEMENT WITH WARRANTY 
TERMS COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH THESE 
TERMS, THE WARRANTY TERMS IN THE 
SEPARATE AGREEMENT WILL CONTROL.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. 
Do not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals 
are provided on the Web. Go to www.keysight.com and type in your product number in 
the Search field at the top of the page.

General This product is a Protection Class 1 instrument (provided with a protective earth terminal) 
and has been manufactured and tested according to international safety standards. The 
protective features of this product may be impaired if it is used in a manner not specified 
in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per 
IEC 60825-1:2014.

Environment Conditions This instrument is intended for indoor use in an Overvoltage Category II, pollution degree 
2 environment. It is designed to operate at a maximum relative humidity of 85% RH, 
non-condensing and at altitudes of up to 2000 meters. Refer to the specifications tables 
for the AC mains voltage requirements and ambient operating temperature range.

Temperature The instrument should be protected from temperature extremes and changes in 
temperature that may cause condensation within it.

The operating temperature is from 5 °C to +40 °C.

The storage temperature is from -40 °C to +70 °C.

Before Applying Power Verify that all safety precautions are taken. The power cable inlet of the instrument serves 
as a device to disconnect from the mains in case of hazard. The instrument must be 
positioned so that the operator can easily access the power cable inlet. When the 
instrument is rack mounted the rack must be provided with an easily accessible mains 
switch.

Ground the Instrument To minimize shock hazard, the instrument chassis and cover must be connected to an 
electrical protective earth ground. The instrument must be connected to the AC power 
mains through a grounded power cable, with the ground wire firmly connected to an 
electrical ground (safety ground) at the power outlet. Any interruption of the protective 
(grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Do Not Operate in an
Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made only by qualified personnel. 

Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

http://www.keysight.com
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Instrument Markings

Instrument Marking Description

The instruction manual symbol. The product is marked with this warning symbol when it 
is necessary for the user to refer to the instructions in the manual.

Standby supply. Unit is not completely disconnected from AC mains when switch is
off. 

The CE mark is a registered trademark of the European Community.

The CSA mark with the 'c' and 'us' subscript indicates the instrument is certified to the 
applicable Canadian and United States of America standards respectively. 

 The RCM mark is a registered trademark of the Australian Communications and Media 
Authority

The KC mark is the Korean certification mark. This equipment is Class A suitable for 
professional use and is for use in electromagnetic environments outside of the home.

The recycling symbol indicates the general ease with which the instrument can be 
recycled.

China Restricted Substance Product Label. The EPUP (environmental protection use
period) number in the center indicates the time period during which no hazardous
or toxic substances or elements are expected to leak or deteriorate during normal
use and generally reflects the expected useful life of the product.
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Compliance and Environmental Information

Table 1  Compliance and Environmental Information

Declaration of Conformity
Declarations of Conformity for this product and for the Keysight products may be 
downloaded from the Web. Go to http://www.keysight.com/go/conformity. 

You can then search by product number to find the latest Declaration of Conformity.

Safety Symbol Description

This product complies with WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex I, 
this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more 
information.
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1 Overview on Keysight SD1 3.x Software
 

Section 1.1: About this document

This document helps you get started with knowing about the key features
that have been included in version 3.x of the Keysight SD1 software. It also
serves as a guide for the required preliminary setup followed by
procedures to install the SD1 3.x software along with its extended
components.
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Overview on Keysight SD1 3.x Software 1

 

Section 1.2: About SD1 3.x software features

The Keysight SD1 3.x Software, which comprises of drivers, programming
libraries and Software Front Panel for the M3100A, M3102A, M3201A,
M3202A, M3300A and M3302A modules, provides a comprehensive
platform to perform the basic operations pertaining to AWGs and
Digitizers. The SD1 3.x software also supports the Hardware FPGA
reprogramming, which is done using the PathWave FPGA Board Support
Package. Moreover, the SD1 API is powered by the KS2201A PathWave
Test Sync Executive software for performing real-time operations and HVI
sequencing.

Figure 1 Model depicting the SD1 3.x software capabilities



12 SD1 3.x Software Startup Guide

1 Overview on Keysight SD1 3.x Software
 

Other than displaying the differences from its predecessor, Table 2
highlights the new features that are available in Keysight SD1 3.x
Software.

Table 2 Differences in SD1 2.x versus SD1 3.x software versions

SD1 software features Legacy (SD1 2.x) New (SD1 3.x)

Software

Design Environment

M3601A HVI design environment (ProcessFlow) KS2201A PathWave Test Sync Executive software 
(HVI2 technology)

M3602A FPGA design environment (FPGAFlow) KF9000A PathWave FPGA Programming 
Environment (commonly known as PathWave FPGA)

HVI Technology1 • Graphical M3601A for HV1
• HVI-C API (through SD1 installer)

KS2201A PathWave Test Sync Executive software 
(HVI2 Core API through a separate HVI installer)

FPGA Programming • Graphical M3602A FPGA Designing (BSP for SD1 2.x only) PathWave FPGA (BSP installer for each supported 
module is required)

Soft Front Panel (SFP) Available Available

Programming Interface Python1, C++, C#, LabVIEW, MATLAB Python1, C, C++, C#, LabVIEW, MATLAB

Supported Operating 
System

Windows 10 Windows 10 (x64 bit)

Hardware Modules

M3202A (AWG 1G) FW version<4.0 (CLF / CLV) (CH2* or CH4) (K16, K32, K41) 
BSP available (K32,K41)

FW version>=4.0 (CLF / CLV**) (CH4) (K16, K32, 
K41)
BSP available (K32, K41)

M3201A (AWG 500) FW version<4.0 (CLF / CLV) (CH2* or CH4) (K16, K32, K41)
BSP available (K32, K41)

FW version>=4.0 (CLF / CLV**) (CH4) (K16, K32, 
K41)
BSP available (K32, K41)

M3102A (DIG 500) FW version<2.0 (CLF / CLV*) (CH2* or CH4) (K16, K32, K41)
BSP available (K32, K41)

FW version>=2.0 (CLF) (CH4) (K16, K32, K41)
BSP available (K32, K41)

M3100A (DIG 100) FW version<2.0 (CLF / CLV*) (CH4 or CH8) (K16, K32, K41)
BSP available (K32, K41)

FW version>=2.0 (CLF) (CH4 or CH8) (K32, K41)
BSP available (K32, K41)

M3302A (COMBO 500 500) FW version<4.0 (CLF / CLV*) (CH2 AWG - CH2 DIG) (K32*, 
K41)
BSP available (K32*, K41)

FW version>=4.0 (CLF) (CH2 AWG - CH2 DIG) (K41)
BSP available (K41)

M3300A (COMBO 500 100) FW version<4.0 (CLF) (CH2 AWG—CH4 DIG or CH4 AWG—CH8 
DIG) (K16*, K32*, K41)
BSP available (K32*)

FW version>=4.0 (CLF) (CH2 AWG—CH4 DIG or 
CH4 AWG—CH8 DIG) (K41)
BSP available (K41)
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1. HVI programming is supported with Python version 3.7 only.

* This Hardware Option cannot be procured. Contact Keysight Support for more information.

** Only Default Clock Speed is supported. Variable Clock is NOT Supported.

https://www.keysight.com/us/en/support/product-support.html


14 SD1 3.x Software Startup Guide

1 Overview on Keysight SD1 3.x Software
 

Section 1.3: About PathWave FPGA and BSP

 1.3.1: Using PathWave FPGA

The SD1 3.x software supports the KF9000A PathWave FPGA
Programming Environment (commonly known as PathWave FPGA) to
program custom logic into the instrument FPGA.

PathWave FPGA provides a complete FPGA design flow from design
creation to simulation to GateWare deployment to Hardware/Gateware
verification. This environment provides an easy-to-use GUI, where you
may create bitstream images targeted to a sandbox in the Keysight FPGA.

Refer to Downloading required software on page 27 for information about
Keysight’s landing page for PathWave FPGA software installer. For more
information regarding the PathWave FPGA software, refer to the
embedded help file or the KF9000A PathWave FPGA Programming
Environment Document Library.

 1.3.2: Using BSP with PathWave FPGA

PathWave FPGA, by itself, does not provide access to any of the waveform
and digitizer controls. which are associated with the supported Keysight
M3xxxA PXIe modules. You must install the Board Support Package (BSP)
to leverage the features within the PathWave FPGA software for your
design.

The Board Support Package (BSP) comprises of two parts—an FPGA
Support Package (FSP) and a Runtime Support Package (RSP). These are
installed separately from PathWave FPGA.

The FSP is that portion of the BSP that allows you to build a bit file for the
target FPGA. It is consumed by PathWave FPGA to support design
creation and sandbox compilation; everything that is performed without
the physical hardware.

NOTE
The PathWave FPGA 2020 is a licensed software. Contact Keysight
Support for more information on procuring the respective licenses.

https://www.keysight.com/main/techSupport.jspx?cc=US&lc=eng&nid=-33330.1244868&pid=2916877&pageMode=OV
https://www.keysight.com/main/techSupport.jspx?cc=US&lc=eng&nid=-33330.1244868&pid=2916877&pageMode=OV
https://www.keysight.com/main/techSupport.jspx?cc=US&lc=eng&nid=-33330.1244868&pid=2916877&pageMode=OV
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The RSP is that portion of the BSP that allows you to control your target
FPGA. It provides a C API that you can use to download and verify your
FPGA bit image. You may use the RSP to load design images onto
hardware and perform simple register and streaming accesses to the one
or more sandboxes.

The FPGA design consists of two regions: the static region and the
sandbox region. The static region for each supported module is defined
with in BSP and cannot  be  modi f ied .  Th is  reg ion def ines  the
implementation of the FPGA interfaces to external resources, and defines
the interfaces to the sandbox. A static region implementation can define
one or more sandbox regions in an FPGA design. The sandbox region
contains the user specific FPGA design. The interface of the sandbox
depends on the static region implementation. A specific design flow is
promoted by PathWave FPGA, called Partial Reconfiguration (PR). In a PR
flow, a full FPGA reconfiguration is only necessary once for a given static
region version. The sandboxes can be reconfigured anytime, without a full
reconfiguration, and without stopping the current operation of the FPGA.

Figure 2 PathWave FPGA compilation flow using BSP

Therefore, each M3xxxA module has a separate BSP installer and you can
only perform FPGA designing for those modules that have BSP installed on
the same machine as the PathWave FPGA software. Both PathWave FPGA
software and the BSP function together and cannot be used individually.

To use front panel analog IO with these modules, it is necessary to use the
SD1 API to control the hardware. A second API is provided to work with
designs created using PathWave FPGA. This API provides convenient
access to the program archive file (the “k7z” file) created by PathWave
FPGA.

You may either use both SD1 and RSP APIs in the program, or use only the
Keysight SD1 API.
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1 Overview on Keysight SD1 3.x Software
 

For installation instructions regarding the PathWave FPGA Board Support
Package, see Installing PathWave FPGA BSP on page 49.

For more information regarding the PathWave FPGA Board Support
Package corresponding to each M3xxxA module, refer to the respective
help file embedded in the PathWave FPGA software.

NOTE
The hardware l icense opt ion -FP1 must be avai lable for  the
implementation of PathWave FPGA BSP on the applicable modules.
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Section 1.4: About KS2201A PathWave Test Sync Executive 
software

The KS2201A PathWave Test Sync Executive software is a programming
environment based on Keysight’s Hard Virtual Instrument (HVI)
technology, that enables you to develop and execute synchronous
real-time operations across multiple instruments. The real-time
sequencing and synchronization capabilities of the PathWave Test Sync
Executive software make it a powerful tool for Multi-Input Multi-Output
(MIMO) applications that require tight synchronization and real-time
control and feedback in areas such as Quantum Computing.

 1.4.1: M3xxxA Firmware version requirements for HVI

The new generation of HVI technology is only programmable by KS2201A
PathWave Test Sync Executive and is not backward compatible with the
previous generation of HVI technology (M3601A).

Table 3 summarizes the firmware versions required for KS2201A operation
on the M3xxxA series of PXI modules. In addition, the SD1 software
provides drivers, programming libraries and soft front panels for the
M3xxxA series. For operation of the KS2201A software, you can use only
version 3.x of the SD1 software.

NOTE
Beginning with SD1 3.x software release, the M3601A Hard Virtual
Instrument (HVI) Design Environment (ProcessFlow) is replaced by the
KS2201A PathWave Test Sync Executive Software for HVI integration. Both
the GUI elements and the API functions from the former HVI design
environment are not supported in the SD1 3.x software.
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1 Overview on Keysight SD1 3.x Software
 

Table 3 Firmware Version Requirements

1. Firmware upgrade/downgrade and SD1 upgrade/downgrade can be performed manually. There is no need to return the module to Keysight. By updating
the firmware on these Keysight products, support for the older generation (M3601A) may be disabled.

2. Note that option HV1 on the M3xxxA modules is required for operation with either KS2201A or M3601A.

 1.4.2: About HVI Technology

HVI technology enables you to program one or multiple instruments to
execute time-deterministic sequences of operations and execute them
with precise synchronization. It achieves this by deploying an executable
code into each instruments HW to be executed by the HVI engine or
processor included integrated into the instrument. The code executes on
these engines in parallel, across multiple instruments. The new
user-defined HW operation of the group of instruments is called a Hard
Virtual Instrument or just HVI. The sequences of operations or instructions
executed by the HVI engines are called HVI sequences. On top of the
advantages inherent of the new use model, several other features have
been added, such as extended multi-chassis capabilities and expanded
product support.

When creating an HVI, you can include any instrument with HVI support.
Keysight’s M3xxxA family of PXI instruments is one product family with HVI
support.

Instrument Drivers, Firmware & Software 
Page

FW version required for use with 
M3601A

FW version required for use with 
KS2201A

M3100A Digitizer M3100A < 2.0 >= 2.0

M3100A Digitizer M3102A < 2.0 >= 2.0

M3201A AWG M3201A < 4.0 >= 4.0

M3202A AWG M3202A < 4.0 >= 4.0

M3300A AWG & Digitizer Combo M3300A < 4.0 >= 4.0

M3302A AWG & Digitizer Combo M3302A < 4.0 >= 4.0
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 1.4.3: About HVI Application Programming Interface

The HVI Application Programming Interface (API)  is the set of
programming classes and methods that allows the user to create and
program an HVI instance. Refer to the KS2201A PathWave Test Sync
Executive User Guide to know more about the HVI Python API.

HVI core functionality is extended by each instrument with an instrument
specific API. The core API is common to all products and only the
instrument specific HVI API will change (instrument instructions, actions,
events), depending on the products. It is important to differentiate
between the core HVI features and the instrument specific extensions,
which allow a heterogeneous array of instruments and resources to coexist
on a common framework.

The HVI Core API exposes all HVI functions and is a common API for all
products. It defines the base interfaces and classes that are used to create
an HVI, control the hardware execution flow, and operate with data,
triggers, events and actions, but it alone does not include the ability to
control instrument specific operations. The core API defines the hardware
virtual instrumentation framework, and it is the job of the product-specific
HVI instrument extensions to enable instrument functionalities in an HVI.

All M3xxxA modules support HVI technology.

When Keysight SD1 is installed on a PXI system, it installs the drivers
required to interact with the M3xxxA series modules. Additionally, the
graphical environment for the Keysight SD1 SFP provides a visual
representation of most of the SD1 API’s features.

The SD1 API classes contains HVI add-on API interfaces provided as an
extension of the instrument. These add-on interfaces provide access to
instrument specific HVI features such as triggering a digitizer acquisition,
outputting a waveform, queuing a waveform, and so on.

NOTE
HVI programming is supported with Python version 3.7 only.

NOTE
The hardware license option -HV1 must be available on each module
that is required to be programmed using the KS2201A PathWave Test
Sync Executive software.
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1 Overview on Keysight SD1 3.x Software
 

For installation and usage instructions regarding the KS2201A PathWave
Test Sync Executive software, refer to the KS2201A PathWave Test Sync
Executive User Guide.
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2 Setting up the SD1 3.x Software
 

Section 2.1: Setting up prerequisites

 2.1.1: System requirements

• Windows 10 (x64 bit)

 2.1.2: Prerequisite software requirements

Table 4 Software to be installed prior to SD1 3.x

*Install this programming interface only if it meets your requirements.

General installation steps for prerequisite software

Perform these steps for installing the software in the sequence shown in
Table 4. 

1 Click the download link and save the installer.

2 Run the downloaded installer.

3 Follow the on-screen instructions.

Sequence Prerequisite software Web Page to download installer from License

1 Keysight IO Libraries Suite 2018 (version 18.1.23218 or later) Click this link to be redirected to the page Free

2 PXIe Chassis firmware — —

3 PXIe Chassis Family Drivers (version 1.7.82.1 or later) Click this link to be redirected to the page —

4 M902x PXIe System Module Driver (version 1.0.94.1 or later), if using 
M90xx remote controllers

Click this link to be redirected to the page —

5 M938x Vector Signal Generator / CW Source Instrument Drivers (version 
2.1.150.4 or later)

Click this link to be redirected to the page —

6 Xilinx Vivado Design Suite (2017.3 or later) Refer to PathWave FPGA Customer Documentation for 
installation and licensing information

7* Python 64-bit version 3.7.x or later https://www.python.org/ Free

8* (optional) Any C# / .NET compiler — —

9* (optional) Any C / C++ compiler — —

https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=2023724&nid=-32188.957143.02&id=2023724
https://www.keysight.com/main/software.jspx?ckey=2747085&lc=eng&cc=US&nid=-11143.0.00&id=2747085
https://www.keysight.com/main/software.jspx?ckey=2235963&lc=eng&cc=LT&nid=-32490.0.00&id=2235963
https://www.keysight.com/main/software.jspx?ckey=2175637&lc=eng&cc=IN&nid=-33330.977662&id=2175637
https://www.python.org/
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For PXIe Chassis drivers and firmware

1 When installing the Keysight Chassis Family Driver, PXIe Chassis SFP
(Software Front Panel) software is automatically installed.

• Chassis firmware version can be checked and updated using PXIe
Chassis SFP.

2 For any other chassis model being used, Keysight recommends
installing the required firmware version and its compatible chassis
driver separately.

Instructions for installing Python

1 Double-click the Python installer, which you have downloaded on your
local machine.

The Python Setup window appears.

Figure 3 Initial Python Setup window

2 Make sure that both options “Install launcher for all users 
(recommended)” and “Add Python 3.7 to PATH” are checked. By 
default, the check box for the former option is selected and it is clear 
for the latter option.

3 Click “Install Now” to install the required Python libraries.
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2 Setting up the SD1 3.x Software
 

Figure 4 Final Python Setup window

4 On the final window pertaining to Python Setup, click “Close” to exit.

5 To verify if the Python installation is successful,

a Launch the command prompt.

b On the root directory, type python and press <Enter>. See Figure 5.

The version information of the current Python installation is
displayed.

Figure 5 Python installation verification on command prompt window

c Ensure that Python has been added to the ‘PATH’ in ‘System
Variables’. If it does not appear, you must manually add an entry.
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 Figure 6 Verifying addition of Python to PATH environment variable

6 On the command prompt window shown in Figure 5, enter the
following commands to install the ‘NumPy’, ‘SciPy’ and ‘Matplotlib’
libraries:

• python -m pip install numpy

• python -m pip install scipy

• python -m pip install matplotlib

After each library is installed, you should see a message “Successfully
installed...”. If you encounter any error, exit the command prompt
window and launch a new one to repeat steps 5b and 6.

The procedure for downloading and installing the SD1 3.x Software, PXIe
module firmware, PathWave FPGA Board Support Package and KS2201A
PathWave Test Sync Executive software are described further in this
chapter.
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Section 2.2: Obtaining License Options

Keysight SD1 3.x software does not require any license to be installed.
However, the software and hardware used with SD1 3.x software require
specific license options that you must procure. Visit the respective product
page on www.keysight.com for pricing details and purchasing Keysight
products.

Table 5 Software License Options required for supported Software (other than SD1 3.x)

Table 6 Hardware License Options Matrix supported by SD1 3.x software

*support for PathWave FPGA BSP on FPGA type K32 / K41 only

**support for KS2201A PathWave Test Sync Executive software in SD1 3.x

***K32 indicates Xilinx 7K325T and K41 indicates Xilinx 7K410T

Note that for migration to the Keysight SD1 3.x software, your hardware
must have the license options listed above for compatibility.

Software License option

PathWave FPGA 2020 Update 1.0 or later Refer to PathWave FPGA Customer Documentation for licensing info.

KS2201A PathWave Test Sync Executive software Refer to the KS2201A PathWave Test Sync Executive User Guide for licensing info.

Xilinx Vivado Design Suite (2017.3 or later) Refer to PathWave FPGA Customer Documentation for licensing info.

Option description M3202A-AWG 
1G

M3201A-AWG 
500

M3102A-DIG 
500

M3100A-DIG 
100

M3302A-AIO 
500+500

M3300A-AIO 
500+100

Channels CH4 CH4 CH4 CH4 or CH8 C22 C24 or C48

Clock (CLF/CLV) CLF or CLV CLF or CLV CLF CLF CLF CLF

Dual Modulation 
(DM1)

DM1 DM1 DM1 DM1 DM1 DM1

FPGA Programming
(FP1*)

FP1 FP1 FP1 FP1 FP1 FP1

HVI Programming
(HV1**)

HV1 HV1 HV1 HV1 HV1 HV1

FPGA type*** K16/K32/K41 K16/K32/K41 K16/K32/K41 K32/K41 K41 K41

Memory
(M01/M12/M20)

Select either of the memory options available for each module
M01 = (16MB, 8MSa) / M12 = (128MB, 60MSa) / M20 = (2GB, 1GSa)

https://www.keysight.com/
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Section 2.3: Downloading required software

The following list points to the web pages on Keysight website, where you
can download the respective software installer files from. Install each
software in the sequence shown in Table 7. Prior to installing one or more
of these software files, you must have installed the software listed under
the section, “Prerequisite software requirements” on page 22.

Table 7 Required software and installer pages

Sequence Prerequisite software Web Page to download installer from

1 Keysight SD1 3.x Software Click here to visit page.

2 SD1 3.x Firmware Update Package Click module name below to visit respective page.
• M3201A
• M3202A
• M3100A
• M3102A
• M3300A
• M3302A

3 KS2201A PathWave Test Sync Executive software Click here to visit page.

4 KF9000A PathWave FPGA Programming Environment (commonly known as 
PathWave FPGA 2020 Update 1.0 or later)

Click here to visit page.

5 PathWave FPGA Board Support Package (BSP) Click module name below to visit respective page.
• M3201A
• M3202A
• M3102A
• M3100A
• M3302A
• M3300A

https://www.keysight.com/main/software.jspx?ckey=3120392&lc=eng&cc=US&nid=-33329.1202211&id=3120392
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=3120633&nid=-54193.4852376.02&id=3120633
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33329.1193059&pid=2747478&pageMode=DS
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=3120640&nid=-54193.4869511.02&id=3120640
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&nid=-54169.4869543.02&id=3120664&pageMode=CV
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=3120651&nid=-54169.4869549.02&id=3120651
https://www.keysight.com/main/redirector.jspx?action=ref&strnid=00&cname=EDITORIAL&ckey=3120682&cc=US&lc=eng&NEWCCLC=USeng
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=3120672&nid=-54193.4869575.02&id=3120672
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33330.1294480&pid=3069213&pageMode=DS
https://www.keysight.com/main/software.jspx?ckey=2954585&lc=eng&cc=US&nid=-33330.1244868&id=2954585
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=3120739&nid=-54193.4852376.02&id=3120739
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&nid=-54193.4869511.02&id=3120742&pageMode=CV
https://www.keysight.com/main/software.jspx?cc=US&lc=eng&ckey=3120745&nid=-54169.4869549.02&id=3120745
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33321.1195633&pid=2747501&pageMode=DS
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33321.1193061&pid=2747490&pageMode=DS
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Section 2.4: Installing required software

The following sections show installation procedure for each software in the
sequence listed in Table 7. Before you begin installing the SD1 3.x
software, you must ensure that all other software listed in “Prerequisite
software requirements” on page 22 are installed on the same machine.

Beginning with version 3.2 onwards, SD1 software supports complete
silent installation. 

To install SD1 software in silent mode, 

1 From the Start menu, launch the Command Prompt window.

2 Change the root folder to the directory where the installer file is placed.

3 Run the following command: 

<SD1-installer-filename> --mode unattended

For example, if SD1software_3.02.08_installer.exe is the installer 
filename, the command will be:

SD1software_3.02.08_installer.exe --mode unattended

 2.4.1: Installing Keysight SD1 3.x software

NOTE
1. While installing SD1 version 3.1 or later on a machine, the installer
detects and automatically removes any existing version of SD1 software
on that machine. However, if SD1 version 3.1 or later is pre-installed,
installing SD1 version 2.x / 3.0 does not automatically remove the
installed SD1 version. To install an older SD1 software version (2.x / 3.0),
you must first manually remove the latest SD1 version using Add or
remove programs utility in the Control Panel in Windows.

2. If you encounter an error, “Unknown error while running C:\Program
Files(x86)\Keysight\SD1\uninstall.exe – mode unattended” when
installing the SD1 software, a likely cause may be an unsuccessful
removal of the previously installed SD1 software. In such cases, manually
clean the following directories: C:\Program Files\Keysight\SD1 and C:\
Program Files (x86)\Keysight\SD1 before trying to install SD1 again.
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1 After you have downloaded the executable file from Keysight.com,
double-click the installer for SD1 3.x Software.

Figure 7 Icon for the SD1 3.x software installer

The following prompt is displayed only if an older version of the SD1
software is installed on your machine. Click Yes to continue.

Figure 8 Prompt to remove previous version of SD1 software

The Welcome window on the SD1 Setup Wizard appears.

Figure 9 Welcome window on the SD1 Setup Wizard
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2 Click Next >. The License Agreement window is displayed.

Figure 10 License Agreement window on the SD1 Setup Wizard

3 From the Do you accept this license? options, select Agree.

4 Click Next >. The Select Components window is displayed.

Figure 11 Select Components window on the SD1 Setup Wizard

By default, all options are selected. However, the option “Keysight
SD1 Library for Labview” is checked and active only if SD1 installer
detects any LabVIEW version installed. Optionally, you may clear the
check box if you choose not to install the LabVIEW drivers.
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Also, if you wish to opt out of using the SD1 API for the M3xxxA
module configuration, you may optionally clear (not recommended)
the check box for “Keysight SD1 Programming Libraries” and
“Keysight SD1 Application Examples”, respectively.

5 Click Next >. The Ready to Install window is displayed.

Figure 12 Ready to Install window on the SD1 Setup Wizard

6 Click Next >. The installation progress window is displayed.

Figure 13 Installation progress window on the SD1 Setup Wizard

During the installation, a separate window appears for the
installation of SD1 device drivers for the M3xxxA modules.
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Figure 14 Welcome window on the Device Driver Installation wizard

7 Click Next >. The completion window on the Device Driver Installation 
Wizard is displayed.

Figure 15 Welcome window on the Device Driver Installation wizard

8 Click Finish.



SD1 3.x Software Startup Guide 33

Setting up the SD1 3.x Software 2

 

The completion window on the SD1 Setup Wizard is displayed.

Figure 16 Completion window on the SD1 Setup wizard

9 Click Finish to complete the software installation and exit the SD1
Setup Wizard.

The following prompt is displayed to restart your machine. Click Yes
to continue (recommended) or No to restart the machine later.

Figure 17 Restart prompt upon completion of setup

Starting with SD1 version 3.2, Python Library will be installed on your
machine as a site package, rather than being placed in the “C:\Program
Files\Keysight\SD1\Libraries\Python” directory. This avoids the need to
manually append the file path for KeysightSD1.py. If multiple Python
versions are installed on your machine, the package is installed for the
default version. 
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The Python wrapper package version for SD1 will be the same as that of
the SD1 software version. You can retrieve this by calling the command:

keysightSD1.<underscore symbol><underscore 
symbol>version<underscore symbol><underscore symbol>

For example, if the SD1 software version is 3.02.03, the command:

keysightSD1.__version__

shall return 3.02.03.

A prerequisite to installing Python Library as a site package is that you
must have pip installed on your machine. It must be functional and added
to the system path to avoid any installation failures. See “Instructions for
installing Python ” on page 23.

NOTE
Spyder users: In order to import the KeysightSD1 library, you must
manually add its path to the Environment Variables. The installation path
f o r  t h e  K e y s i g h t S D 1  L i b r a r y  i s  “ < P y t h o n  I n s t a l l a t i o n
Directory>/Lib/site-packages/KeysightSD1”.
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 2.4.2: Installing M3xxxA Module Firmware updates

Prerequisite

The Keysight SD1 3.x software must be installed to update your module
firmware.

Downloading the Firmware

Online FW updates Firmware updates are available online and the Hardware Manager
connects automatically to the FW database to obtain the latest available
releases and previous ones as well. 

Offline FW updates If the chassis controller has no internet access, you can still perform
updates offline. However, you are still required to download, in advance,
the desired firmware update from the target module web page on
Keysight.com.

1 Navigate to your module’s ‘Technical Support’ page

2 In the “Drivers, Firmware & Software” tab, click the “Firmware Update
Package for M3xxxA” link.

3 Click ‘Download’ corresponding to the latest version to save the file at
the desired location on your machine.

Table 8 shows pointers to the Technical Support page for each module.

Table 8 Technical Support for M3xxxxA product family

NOTE
Keysight SD1 3.x software does not recognize cards that have Firmware
version less than 4.0 (for M32xxA/M33xxA modules) or less than 2.0 (for
M31xxA modules). Therefore, updating firmware on your cards is
imperative for undisrupted functionality.

PXIe M3xxxxA product Keysight Technical Support page link for Firmware Update file

M3201A AWG 500 Firmware Update Package for M3201A

M3202A AWG 1G Firmware Update Package for M3202A

M3100A DIG 100 Firmware Update Package for M3100A

https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33321.1189552&pid=2732831&pageMode=DS
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33321.1193058&pid=2747446&pageMode=DS
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33329.1193059&pid=2747478&pageMode=DS


36 SD1 3.x Software Startup Guide

2 Setting up the SD1 3.x Software
 

Updating the Firmware

1 Launch the Keysight SD1 SFP software from the Start menu.

2 From the main menu of the SD1 software, click Help > Hardware
Manager....

Figure 18 Accessing Hardware Manager menu option in SFP

3 Check the module, whose Firmware needs update, in the list of
available modules on the Hardware Manager window.

• If the chassis controller is online with internet connection, the
available FW releases are shown automatically. Skip to step 6.

M3102A DIG 500 Firmware Update Package for M3102A

M3300A AWG 500 DIG 100 Firmware Update Package for M3300A

M3302A AWG 500 DIG 500 Firmware Update Package for M3302A

PXIe M3xxxxA product Keysight Technical Support page link for Firmware Update file

https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33329.1202211&pid=2747485&pageMode=DS
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33321.1193061&pid=2747490&pageMode=DS
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-33321.1195633&pid=2747501&pageMode=DS
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• If the system is offline or for some reason, the connection to the FW
server fails and the Available FW Version list is displayed as empty
or not fully up-to-date. See Figure 19. Proceed with step 4.

Figure 19 Available FW Version list empty or outdated in offline mode
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For offline updates 4 From the main menu of the Hardware Manager window, click File >
Load update package....

Figure 20 Accessing Load Update Package option in File menu
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5 From the Load SDM package... window that appears, select the update 
package file for the required module and click Open.

Figure 21 Opening the Firmware update package for the module
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For both online &
offline updates

6 The Available FW Version list in the Hardware Manager window is 
refreshed and available versions are displayed. Select Yes from the 
Update drop-down options for the module that requires updates.

Figure 22 Latest FW versions displayed for HW update

7 Click Update Selected HW. 

8 An Update Confirmation dialog is displayed. Click Yes to continue.

9 When the firmware programing process finishes, you must
SHUTDOWN your machine (and not restart) if you want to use the new
version of your firmware in your module.

10 Start your machine to check the new uploaded firmware version of 
your module in the Hardware Manager window of the SD1 Software 
Front Panel. You would see the current module firmware version as the 
desired updated firmware version.
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Figure 23 Latest FW versions displayed for HW update

While launching, if the SD1 SFP detects an incompatible firmware version 
for any module against the installed version of the SD1 software, the SD1 
SFP prompts the following error for the module:

Figure 24 SD1 SFP Error for incompatible FW version
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Similarly, for the supported firmware version on the module, if the SD1 
SFP fails to open the card, it prompts the following error:

Figure 25 SD1 SFP Error for incompatible SW version
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 2.4.3: Installing KS2201A PathWave Test Sync Executive 
software

Note that the KS2201A PathWave Test Sync Executive software is not a
standalone software. It enhances the Keysight SD1 API to support HVI
technology by adding the DLLs required for programming libraries.
Therefore, the Keysight SD1 3.x software must already be installed on the
same machine.

Refer to the KS2201A PathWave Test Sync Executive User Guide for
installation instructions and to know about the licenses that you must
procure for the KS2201A PathWave Test Sync Executive software.

NOTE
All M3xxxA modules support HVI technology. However, the hardware
license option -HV1 must be available on each module that is required to
be programmed using the KS2201A PathWave Test Sync Executive
software and for usability with SD1 3.x software.
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 2.4.4: Installing PathWave FPGA software

1 After you have downloaded the executable file from Keysight.com,
double-click the installer for PathWave FPGA software.

Figure 26 Icon for the PathWave FPGA software installer

NOTE
The PathWave FPGA 2020 is a licensed software. Also, the hardware
license option -FP1 must be enabled on the supported modules for
FPGA programming using PathWave FPGA BSP and for usability with
SD1 3.x software. Contact Keysight Support for more information on
procuring the respective licenses.
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The Welcome window on the PathWave FPGA 2020 Update 1.0
Setup Wizard appears.

Figure 27 Welcome window in the PathWave FPGA Setup Wizard

2 Click Next >. The License Agreement window is displayed.

Figure 28 License Agreement window in the PathWave FPGA Setup Wizard

3 From the Do you accept this license? options, select I accept the
agreement.

4 Click Next >. The Installation Directory window is displayed.
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Figure 29 Select Components window in the PathWave FPGA Setup Wizard

I f  requ i red ,  modi f y  the  ins ta l la t ion  d i rectory  path  (not
recommended).
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5 Click Next >. The Ready to Install window is displayed.

Figure 30 Ready to Install window in the PathWave FPGA Setup Wizard

6 Click Next >. The installation progress window is displayed.

Figure 31 Installation progress window in the PathWave FPGA Setup Wizard

The completion window in the PathWave FPGA Setup Wizard is
displayed.
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Figure 32 Completion window in the PathWave FPGA Setup wizard

7 Click Finish to complete the software installation and exit the
PathWave FPGA Setup Wizard.
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 2.4.5: Installing PathWave FPGA BSP

Besides selecting the Channel configuration during procurement, you
must also choose to include one of the two possible Xilinx FPGAs on your
M3xxxA PXIe module:

1. xc7k410tffg676-2

2. xc7k325tffg676-2

The xc7k410tffg676-2 part offers you a substantial increase in the amount
of FPGA resources required for custom logic.

Along with the Xilinx FPGAs, the hardware license option -FP1 must be
available for the implementation of PathWave FPGA BSP on the applicable
modules.

As mentioned earlier, each M3xxxA module has a separate BSP installer,
which can be downloaded from the PathWave FPGA Board Support
Package web page on Keysight.com and you can only perform FPGA
designing for those modules that have BSP installed on the same machine
as the PathWave FPGA software. Both PathWave FPGA software and the
BSP function together and cannot be used individually.

Other than the prerequisite software listed earlier, before you begin
installing the PathWave FPGA BSP utility for any module, you must ensure
that the PathWave FPGA 2020 software (along with Xilinx Vivado Design
Suite) are installed on the same machine.

The captured images displayed here pertain to BSP package (2.55.0) for
FW2.01.15 of M3102A. For the other supported modules (that is, M3201A
and M3202A), the corresponding BSP package version and FW version are
different but each of them follow the same prerequisites and installation
procedure.

NOTE
Keysight SD1 3.x software supports PathWave FPGA BSP on all M3xxxA
modules, with the condition that the license option -FP1 must be
enabled for FPGA programming using PathWave FPGA BSP.
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1 After you have downloaded the executable file from Keysight.com,
double-click the installer for SD1 3.x Software.

Figure 33 Icon for the SD1 3.x software installer

The Welcome window on the BSP Setup Wizard appears.

Figure 34 Welcome window on the BSP Setup Wizard
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2 Click Next >. The License Agreement window is displayed.

Figure 35 License Agreement window on the BSP Setup Wizard

3 From the Do you accept this license? options, select I accept the
agreement.

4 Click Next >. The Installation Directory window is displayed.

Figure 36 Installation Directory window on the BSP Setup Wizard

A default location appears in the Installation Directory field.

If you wish to change the directory location, click the associated
folder icon to navigate and to select the desired folder.



52 SD1 3.x Software Startup Guide

2 Setting up the SD1 3.x Software
 

5 Click Next >. The Ready to Install window is displayed.

Figure 37 Ready to Install window on the BSP Setup Wizard

6 Click Next >. The installation progress window is displayed.

Figure 38 Installation progress window on the BSP Setup Wizard
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The completion window on the BSP Setup Wizard is displayed.

Figure 39 Completion window on the BSP Setup wizard

7 Click Finish to complete the software installation and exit the BSP
Setup Wizard for the corresponding module.

8 Repeat the steps above to install BSP for the other supported modules.

9 To verify that the BSP has been properly installed, navigate to “C:\
Program Files\Keysight” folder and look for the “M3xxxA BSP” folder,
which corresponds to the module for which BSP is installed.

The sub-folder “R0n0abc” indicates the BSP version installed, where n
= 2 (for M3102A) and n = 4 (for M3201A/M3202A) and abc = any value
greater than 0. In this example, the BSP files are installed in C:\Program
Files\Keysight\M3102A BSP\R020115.

10 Alternatively, launch the PathWave FPGA software and create a new
project to verify that the installed BSP module appears as an option.
See “Launching the PathWave FPGA BSP” on page 58 for details.
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Section 2.5: Launching the Software

 2.5.1: Launching the SD1 SFP user interface

Once you have installed the Keysight SD1 3.x SFP software, you can
launch the Soft Front Panel (SFP) from the Start menu.

1 On your Win10 OS, click Start > Keysight > Keysight SD1 SFP.

Figure 40 Launching SFP from the Start Menu

While launching, the Keysight SD1 SFP software auto-detects all
M3xxxA cards that are connected and auto-assigns Module
numbers to each of them. A main window is displayed along with a
panel for each PXIe M3xxxxA card that is connected.

For example, in Figure 41, the M3201A AWG card and M3302A
(AWG + Digitizer) Combo cards are inserted in the machine and the
SFP software has assigned Module numbers as shown.

All offline modules can be accessed via the Window menu of the
Keysight SD1 SFP software.
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Figure 41 Modules displayed in the default window of SD1 SFP software

For more information regarding the features and functionality of the
Keysight SD1 SFP software, refer to the corresponding Module User
Guide, which can be accessed via the Help menu for each module’s panel.
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 2.5.2: Launching SD1 Core API

You may access the SD1 Core API to control and configure the connected
instruments using the ‘keysightSD1’ Library available in Python, C/C++
and .NET programming languages.

To invoke an API function for the connected instrument,

1 Launch the interface for the programming language of your choice.

2 Import the SD1 library along with the AWG/Digitizer commands.

3 Proceed with creating objects and defining values based on your
requirements.

The following work flow, using Python commands, shows how to use
Keysight SD1 Programming Libraries:

1 Import required system components and python libraries (as needed).

Examples:
import sys

import os
import matplotlib.pyplot as plt
import numpy as np

2 Import the SD1 Python library for AWG/Digitizer commands.

Example:
import keysightSD1 as key

3 Proceed with creating module objects and defining other
AWG/Digitizer functions

For more information regarding SD1 API programming functions, refer to
the User Guide for M31xxA/M32xxA and M33xxA modules, which can be
accessed from the Document Library page for each product on
Keysight.com.
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 2.5.3: Launching an HVI Application

As mentioned earlier, the KS2201A PathWave Test Sync Executive
software is not a standalone software. It enhances the Keysight SD1 API to
support HVI technology by adding the DLL files required for Python
libraries. After you install the KS2201A PathWave Test Sync Executive
software, you can find these files in C:\Program Files\Keysight\Pathwave
Test Sync Executive 2020\api\python\.

The HVI API within the KS2201A PathWave Test Sync Executive software
consists of classes that provide native HVI functionalities that are common
across any measurement instrument deployed within an HVI system.

To use the HVI API in Python, import the HVI API Python package that is
included with the HVI installer. This will be your first part of your code in
each of your files. Unless this package is imported, the HVI API will not be
found.

The following work flow, using Python commands, shows how to add HVI
library to an application and create an HVI instance. 

1 Import required system components and python libraries (as needed).

Examples:
import sys
import os
import time
import matplotlib.pyplot as plt

import numpy as np

2 Import the SD1 Python library for AWG/Digitizer commands.

Example:
import keysightSD1 as key

3 Import the HVI library to create an HVI instance.

Example:
import keysight_hvi as kthvi

4 Create KtHvi instance

Example:
module_resource_name = 'KtHvi'
hvi = kthvi.Hvi(module_resource_name)

NOTE
HVI programming is supported with Python version 3.7 only.
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5 Add each engine to the KtHvi instance

Example:
hvi.engines.add(module.hvi.engines.main_engine, “engine_name”)

6 Based on your requirements, you may proceed with defining HVI
resources (actions, events, triggers), programming HVI sequences and
compiling, loading and executing the HVI application.

The HVI functions corresponding to SD1 API can be found in the SD1 3.x
Software User Guide (for M32xxA/M33xxA AWGs and for M31xxA/M33xxA
Digitizers).

The complete description of the HVI Python API can be found in the help
file that is provided with the HVI installer, available in:

C:\Program Files\Keysight\Pathwave Test Sync Executive 2020\api\
python\Help

 2.5.4: Launching the PathWave FPGA BSP

The PathWave FPGA 2020 software and the Board Support Package (BSP)
are inter-dependent and must be brought together to achieve the desired
output.

Once you have installed the PathWave FPGA 2020 software, you can
launch its user interface from the Start menu.

1 On your Win10 OS, click Start > Keysight PathWave FPGA 2020
Update 1.0 > Keysight PathWave FPGA 2020 Update 1.0.

Figure 42 Launching PathWave FPGA 2020 from the Start Menu

The PathWave FPGA 2020 Update 1.0 software’s main window
appears as displayed in Figure 43. 
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Figure 43 Default window of the PathWave FPGA 2020 software

If, at this point, the BSP software for either of the supported modules is not
installed, the PathWave FPGA prompts the error shown in Figure 44, when
you try to create a new project.

Figure 44 Error prompted by PathWave FPGA 2020 if no BSP is installed

Therefore, BSP for one or more supported modules must be installed even
to proceed further with creating a new project in PathWave FPGA.
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After you install BSP for one or more modules, you can proceed with
creating a new project to design the sandbox region for the corresponding
modules. In this way, you can verify if the BSP is installed successfully or
not.

1 On the main window of the PathWave FPGA 2020 software, click the
icon for new project.

A new sandbox project dialog appears.

Figure 45 Creating a new Sandbox project

2 Click Next >.
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3 For the Project Type, choose the BSP corresponding to one of the
modules whose FPGA you wish to update. If the module name
corresponding to the installed BSP appears here, it indicates that the
BSP is successfully installed.

Figure 46 Selecting the module-specific BSP

Additional Steps

Once you design your custom FPGA logic on the selected module, you may
generate the Bitstream file (k7z file), which can then be loaded onto the
FPGA module using either the SD1 API or the Load Firmware feature
(under FPGA menu of the Module panel in the SFP software) for
compatibility verification.

For detailed instructions on generating the Bitstream file and to
understand the features of the PathWave FPGA 2020 software, refer to the
PathWave FPGA Help file accessible via the Help menu of the software.

Following steps give you a quick glance into generating a bitstream file for
an M3102A module using the PathWave FPGA BSP software.

1 Towards the end of a new project creation, verify all information
displayed in the Project Summary. To make any amendments, click
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Back .  If  the selected options for the corresponding BSP are
satisfactory, click Finish.

Figure 47 Viewing the project summary information
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2 Customize the configuration as per your requirements using one or
more elements from the Design Interfaces and IP Catalog panels.

3 After you have designed your FPGA logic, you can proceed with the k7z
file generation. Click the Generate Bit File... icon as shown in
Figure 48.

Figure 48 Initiating Bit File generation for the selected module

If you do not have the Xilinx Vivado Design Suite on the same
machine where PathWave FPGA 2020 software and BSP are
installed, the following error is prompted when you click the
Generate Bit File... icon.
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4 On the FPGA Hardware Build window that appears, click Run.

Figure 49 Generating FPGA Hardware Build
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Depending on the configuration, the software takes some time
before finishing the process of k7z file generation.

Figure 50 Progress status for the k7z file generation

Thereafter, you may use the SD1 API or the SFP GUI to load the k7z file on
the hardware.

To know about loading the k7z file, Refer to the BSP User Guide for the
corresponding modules, which can be accessed via Help > BSPs Help
menu options in the PathWave FPGA 2020 software.
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Section 3.1: Troubleshooting Installation

• If installing the complete/hardware install and the installer is stalling
for long periods or failing installing Keysight IO Libraries, try
downloading and installing Keysight IO Libraries directly from:

• http://www.keysight/com/find/iolibs

• Select the 2019 U1 version (Build 18.1.24715.0)

• For Keysight support for help with tools and documentation or to
connect with a technical support expert for product and service
support, see http://www.keysight.com/find/support.
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Section 3.2: FAQs

Question 1 I installed KS2201A PathWave Test Sync Executive software but i am
unable to use it for my M3xxxA products. What should I do?

Answer 1 Check if you have Keysight SD1 SFP software version 3.x or later
installed on your machine.

2 Upgrade the Firmware of the cards to a version greater than or equal to
4.0 (for M32xxA / M33xxA) or 2.0 (for M31xxA).

3 The license option -HV1 must be enabled to support programming
using KS2201A PathWave Test Sync Executive software.

Question 2 Does Keysight SD1 SFP software version 3.x or later recognize M3xxxA
products that have Firmware versions less than 4.0 (for M32xxA / M33xxA)
or 2.0 (for M31xxA)?

Answer No. Keysight SD1 SFP software version 3.x or later will not recognize the
older cards. You may:

1 Upgrade the Firmware of the cards to a version greater than or equal to
4.0 (for M32xxA / M33xxA) or 2.0 (for M31xxA).

2 Contact Keysight Sales to upgrade your hardware.

Question 3 Can I still use M3601A HVI design environment (ProcessFlow) and M3602A
FPGA design environment (FPGAFlow) after upgrading my M3xxxA
products?

Answer No.

• The KS2201A PathWave Test Sync Executive software will be
supported on modules for SD1 3.x software that have firmware version
greater than or equal to 4.0 (for M32xxA / M33xxA) or 2.0 (for M31xxA)
and each card must have the license option -HV1 enabled.

• The PathWave FPGA BSP software will be supported on cards with
firmware version greater than or equal to 4.0 (for M3201A / M3202A) or
2.0 (for M3102A) and each card must have the license option -FP1
enabled for FPGA programming.

Question 3 Can I use components of Keysight SD1 SFP software version 3.0 or later
along with the legacy version on the same machine?

Answer No. The installer for Keysight SD1 SFP software version 3.0 (or later)
removes all legacy (SD1 2.x.x) components. Hence, both versions cannot
co-exist on the same machine.
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Question 4 Why don’t I have the option to upgrade Firmware version from SD1 2.x to
that compatible with SD1 3.x software?

Answer You must have the M3xxxA Hardware Options as listed in Table 6,
“Hardware License Options Matrix supported by SD1 3.x software”, which
is supported by SD1 3.x Software. Not all Hardware options supported on
SD1 2.x software are now supported on SD1 3.x software.

Question 5 Why is the PathWave FPGA software prompting me a license error
regarding existing Firmware/BSP compatibility with SD1 3.x software,
where the same Firmware/BSP used to work with SD1 2.x software?

Answer You must upgrade the supported M3xxxA modules with hardware license
option -FP1. Earlier, this hardware license option was included as a Zero
dollar (free) option for SD1 2.x software. Now, the Zero dollar scheme has
been discontinued. You must have a valid -FP1 license option for support
with PathWave FPGA functionality.
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Section 3.3: References to other documents

Table 9 Reference document titles and access links

Document Reference Reference location

SD1 3.x Software for M320xA/M330xA PXIe 
Arbitrary Waveform Generators User’s Guide

http://literature.cdn.keysight.com/litweb/pdf/M3XXX-90003.pdf

SD1 3.x Software for M310xA/M330xA PXIe 
Digitizers User’s Guide

http://literature.cdn.keysight.com/litweb/pdf/M3XXX-90004.pdf

KS2201A PathWave Test Sync Executive User 
Guide

Visit KS2201A Document Library.

KF9000A PathWave FPGA Customer 
Documentation

Visit KF9000A PathWave FPGA Programming Environment Document Library.
PathWave FPGA Customer Documentation can be accessed from the Help menu of the design 
environment.

BSP Guides

M3102A PXIe Digitizer Accessed from the Help menu of the PathWave FPGA 2020 Update 1.0 design environment.

M3100A PXIe Digitizer Accessed from the Help menu of the PathWave FPGA 2020 Update 1.0 design environment.

M3201A PXIe Arbitrary Waveform Generator Accessed from the Help menu of the PathWave FPGA 2020 Update 1.0 design environment.

M3202A PXIe Arbitrary Waveform Generator Accessed from the Help menu of the PathWave FPGA 2020 Update 1.0 design environment.

M3302A PXIe AWG & Digitizer Combination Accessed from the Help menu of the PathWave FPGA 2020 Update 1.0 design environment.

M3300A PXIe AWG & Digitizer Combination Accessed from the Help menu of the PathWave FPGA 2020 Update 1.0 design environment.

Data Sheets

M3100A PXIe Digitizers with Optional Real-Time 
Sequencing and FPGA Programming

https://www.keysight.com/us/en/assets/7018-05400/data-sheets/5992-1806.pdf

M3102A PXIe Digitizers with Optional Real-Time 
Sequencing and FPGA Programming

https://www.keysight.com/us/en/assets/7018-05399/data-sheets/5992-1805.pdf

M3201A PXIe Arbitrary Waveform Generator with 
Optional Real-Time Sequencing and FPGA 
Programming

https://www.keysight.com/us/en/assets/7018-05391/data-sheets/5992-1797.pdf

https://www.keysight.com/main/techSupport.jspx?cc=US&lc=eng&nid=-33330.1244868&pid=2916877&pageMode=OV
https://www.keysight.com/us/en/assets/7018-05400/data-sheets/5992-1806.pdf
https://www.keysight.com/us/en/assets/7018-05399/data-sheets/5992-1805.pdf
https://www.keysight.com/us/en/assets/7018-05391/data-sheets/5992-1797.pdf
http://literature.cdn.keysight.com/litweb/pdf/M3XXX-90003.pdf
http://literature.cdn.keysight.com/litweb/pdf/M3XXX-90004.pdf
https://www.keysight.com/main/techSupport.jspx?cc=US&lc=eng&nid=-54165.5242627&pid=3069213&pageMode=OV
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M3202A PXIe Arbitrary Waveform Generator with 
Optional Real-Time Sequencing and FPGA 
Programming

https://www.keysight.com/us/en/assets/7018-05392/data-sheets/5992-1798.pdf

M3300A PXIe Arbitrary Waveform 
Generator/Digitizer with Optional Real-Time 
Sequencing & FPGA Programming

https://www.keysight.com/us/en/assets/7018-05403/data-sheets/5992-1809.pdf

M3302A PXIe Arbitrary Waveform 
Generator/Digitizer with Optional Real-Time 
Sequencing & FPGA Programming

https://www.keysight.com/us/en/assets/7018-05402/data-sheets/5992-1808.pdf

Document Reference Reference location

https://www.keysight.com/us/en/assets/7018-05392/data-sheets/5992-1798.pdf
https://www.keysight.com/us/en/assets/7018-05403/data-sheets/5992-1809.pdf
https://www.keysight.com/us/en/assets/7018-05402/data-sheets/5992-1808.pdf
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